The University of Minnesota
Graduate School

UNIVERSITY OF MINNESOTA

Preparing the Thesis/Design Project
Formatting = Submitting = Publishing

Plan A and Professional Engineering Only

Graduate Student Services and Progress Office - 612-625-3490
316 Johnston Hall - 101 Pleasant St SE - Minneapolis, MN 55455



Table of Contents

INTFOAUCTION i e et e e e e e e e e e aaan s 2
BefOre YOU BeQIN oo 2
Section 1: Formatting the Master’'s ThesSiS ..., 3
Mechanics and Formatting Specifications .............ccccccc, 3
1= o 1] 1 PSRN 3
Acceptable FONS ......cooii i 3
Pagination ...........ooouiiiiiii 4
Introductory Material .................uuviiiiiiiiiiiiiiiiie 4
Figure 1: Order of Introductory Material .................... 6
Body of the Manuscript ... 7
Table 1: Order and Pagination of the Thesis ............ccoevvviiiiiiiienenn. 8
Page Numbering Using Microsoft Word (PC)........ccoovvviiiiiiiiiiinnnnns 8
Page Numbering Using Microsoft Word (MAC) ...........ccceeeiieeiiiinnnn, 9
Formatting Landscape Pages..........ccooeeeieeei 10
Published Work Included as Part of the Thesis.............ccccoeei. 11
Corrections and ReVISIONS ...........cuuuiiiiiiiieiiieeiiier e 12
Thesis Writing SUPPOI.......ccooommiiiiie e 12
Section 2: Submitting the Master’'s ThesSiS.......ccccvvviiiiiii e, 13
Overview of Submission OptioNS ........cccooeeiiiiiiiiii e, 13
Option 1: Graduate School Thesis Submission (Electronic)..................... 14
Submitting the Electronic Thesis ........cccooeeieeiiiiiiiiiiiieeeee, 14
Converting Documents to PDF ... 15
Materials Submitted to GSSP ..., 16
University of Minnesota Digital Conservancy .............cccooeeeiiiiinnns 16
Thesis Embargo Request.............cooiiiiiiiiiiii e, 17
Option 2: Graduate School Thesis Submission (Paper)...........cccccevvveeeee. 19
Submitting the paper thesis ..., 19
Paper and VOIUMES ..........oooviiiiiiiiec e 19
lllustrative Materials..............ooooiiiiii 19
Thesis Embargo Request...............uuuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiis 20
Materials Submitted to GSSP ..., 21
Option 3: ProQuest Thesis Submission (Electronic) ..................euvvveeenneee. 22
Submitting the Thesis to ProQuest............ccoovvviiiiiiiiiiie e, 22
Publication, Copyright, and Distribution of the Thesis ................... 23
COSt 24
ADSErACT ... 24
(0] o)/ o | o | AP 24
University of Minnesota Digital Conservancy .............cccooeeeiiiiiinnns 26
Thesis Embargo Request...........c.ooiiiiiiiiiiii e, 27

Section 3: Appendices
Appendix A—Formatting Guidelines Checklist ................ccoovriiiiiiiii, 29
Appendix B—Ordering Copies for Graduate Program or Personal Use.............. 30
Appendix C—Thesis Submission Comparison Guide.............ccoeevvviieieiiiiiieeeennnn. 31

GS13 09/09 1



Introduction

The master’s Plan A thesis or design project (thesis) is not only a representation
of a student’s academic work but also a reflection on the faculty adviser, the
graduate program, the Graduate School, and the University of Minnesota. Once
a student has submitted a thesis to the Graduate School, it will be available for
other scholars to view. Professional, consistent presentation of this work is
essential. The following information has been assembled so students can know
what the Graduate School requires in order to successfully present the
culmination of their efforts as a master’s student.

This document outlines the formatting specifications for preparing the thesis.
Students are required to follow these guidelines. The Graduate School will
accept only theses that meet these requirements. Failure to apply these
standards may result in the delay of a student’s degree conferral. In
addition to the Graduate School’s formatting guidelines, students should be sure
to follow stylistic conventions of their graduate program. Because these
conventions vary greatly from one field to another, students should consult with
their faculty adviser or Director of Graduate Studies (DGS) regarding
recommended style manuals. The University Libraries staff may also be
consulted for information about style manuals.

Before submitting the thesis, students are encouraged to contact the Graduate
Student Services and Progress (GSSP) office in 316 Johnston Hall,
(gsmast@umn.edu) with any questions about this manual, or if they would like
the thesis to be reviewed for formatting.

Before You Begin

Students should keep the following in mind when putting together the thesis for
submission:

= The Graduate School has provided simple thesis templates for master’s
students working in either Microsoft Word or LaTex, available online at
http://www.grad.umn.edu/current _students/masters/submission.html.
Students using the templates remain responsible for ensuring that the
thesis meets the Graduate School’s formatting guidelines outlined in this
document as well as requirements of their graduate program and field-
specific guidelines.

= The thesis must read as one cohesive document. It must include one set
of introductory pages (acknowledgments, abstract, table of contents, etc.),
one introduction, and one comprehensive bibliography at the end of the
thesis.

= Upon submission of the thesis, students may expect to receive notice of
required formatting updates. Typically, these are minimal.
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SECTION 1: FORMATTING THE MASTER’S THESIS

Mechanics and Formatting Specifications

Margins

Every page of the thesis, including all appendices, notes, and the
bibliography, must have a left margin of at least 1.5 inches (3.9cm), and
top, right, and bottom margins of at least 1 inch (2.6cm).

Nothing can appear in the margins, which means that no page numbers,
text, tables, graphs, charts, parts of illustrations, etc., can appear in the
margin area.

Before submitting the final version of the thesis, the Graduate School
suggests printing sample pages to measure the margins and ensure that
they conform to the specifications outlined above.

Acceptable Fonts

Standard fonts, such as Times New Roman, Helvetica, Arial, and Courier,
are accepted by the Graduate School.

Students should confer with their faculty adviser or DGS to ensure that the
chosen font meets graduate program requirements.

The Graduate School requires at minimum a 10-point font for the body of
the text.

The Graduate School accepts the use of different fonts to set off
examples, quotations, tables, and charts from the rest of the text, as long
as all fonts are of a similar size and easily readable. In addition,
footnotes, section headings, and chapter titles may be printed in fonts and
sizes different from those in the body of the thesis. The size of these
characters should be no smaller than 9 point. Students should confer
with their faculty adviser or DGS to ensure that use of various fonts and
font sizes meets graduate program requirements as well.

Spacing
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The Graduate School requires that the body of the thesis be double-
spaced or 174-spaced.

Long quotations, notes, and the bibliography may be single-spaced unless
the student’s graduate program requires otherwise.



Pagination

Students are responsible for correctly numbering and organizing sections in their
theses. Page numbers may appear only in the upper or lower right corners or the
bottom center of the page. Page numbers on the left side of the page are not
acceptable.

Introductory Material

The title page, copyright page, acknowledgments, dedication, abstract,
table of contents, list of tables, and list of figures are considered the
introductory material of the manuscript.

The title page and copyright page must not be numbered or counted.
Page numbers for the rest of the introductory material is required,
expressed in lower-case Roman numerals, beginning with page “i.”
Introductory material must appear in the order shown in Figure 1.

The thesis may include other items that should be listed in the introductory
material, such as notations, list of abbreviations, etc. These items should
be included at the end of the introductory materials identified above,
keeping with the numbering scheme outlined below. If it is unclear
whether or not a section should be included with the standard introductory
pages, please contact GSSP (gsmast@umn.edu , 316 Johnston Hall).

Signature Page

The adviser (and co-adviser if applicable) must sign the signature page to
confirm seeing and approving the final version of the thesis.

A specially designed signature page, with a sketch of Northrop Auditorium
in the background, is available in 316 Johnston Hall.

Title Page

The title page, which is not numbered or counted, must be included as
the first page of the thesis.

The month and year that degree requirements were met must be included
(not necessarily the month and year the student defends).

The title of the thesis must not contain chemical or mathematical
formulas, symbols, superscripts, subscripts, Greek letters, or other non-
standard characters; words must be substituted.

The title page must include only one title for the thesis.

The student’s name listed on the title page must be the official name on
record with the Office of the Registrar.
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Copyright Page

= The copyright page, which is not numbered or counted, is required.

= Even if the student is not registering the thesis with the U.S. Copyright
Office, a copyright page is required to protect their original work.

= The copyright page is separate from the title page. The student’s official
name on record with the Office of the Registrar, the year of graduation,
and a copyright symbol © or the word “copyright” are required.

Acknowledgements Page

= An acknowledgements page is optional.
= |[fincluded, it is numbered in lower-case Roman numerals and counted.

Dedication Page

= A dedication page is optional.
= [fincluded, it is numbered in lower-case Roman numerals and counted.

Abstract

* |ncluding an abstract in the thesis is optional.
= [fincluded, it is numbered in lower-case Roman numerals and counted.

Table of Contents

= Atable of contents is required.

= |tis numbered in lower-case Roman numerals and counted.

= The table of contents must include corresponding page numbers
referencing each section.

List of Tables

= A page with a list of tables is required if tables are included in the thesis.

= The list must include the table number, title, and corresponding page
number for each table.

= |tis numbered in lower-case Roman numerals and counted.

= The list of tables must be represented in the table of contents.

List of Figures

= Alist of figures page is required if figures are included in the thesis.

= The list must include the figure number, title, and corresponding page
number for each figure.

= |tis numbered in lower-case Roman numerals and counted
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= The list of figures must be represented in the table of contents.

Other Items

= |f other pages are included with the introductory materials (e.g. list of
abbreviations, list of notations, etc.), they must be numbered in lower-
case Roman numerals and counted as well as represented in the table of
contents.

Figure 1: Order of Introductory Material

This figure is for illustrative purposes only and shows a basic example of how
introductory pages must be numbered. If any of these items is longer than one page,
the additional pages must be numbered consecutively. Reminder: Not all theses

will include the optional pages.

List of Figures vi

List of Tables \Y;

Table of Contents iv

Abstract iii

Dedication ii

Acknowledgments i

Copyright Page
Not numbered or counted

] Title Page
Not numbered or counted
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Body of the Manuscript

= The main text, illustrations, bibliography, and appendices are considered
the body of the manuscript.

= Every page in the body of the text, through the bibliography and
appendices, must be numbered in Arabic numerals starting with page 1.

= The first page of the body of the manuscript (introduction, chapter one,
etc.), must start with an Arabic numeral one (1). If it is unclear whether a
section counts as part of the body of the manuscript, please contact GSSP
(gsmast@umn.edu).

lllustrations

= All illustrative materials (e.g., figures, tables, charts, and graphs) must
have a figure number and a page number and must conform to the margin
specifications, regardless of where the figure caption is located.

Bibliography

= The bibliography may be single-spaced and must appear as the last
section of the thesis unless appendices are included (see below).

= |tis not acceptable to include separate references after each chapter
instead of as a single cumulative bibliography at the end of the thesis.

= The bibliography must be represented in the table of contents.

Appendices

= The appendices are an integral part of the thesis and must conform to all
the formatting specifications outlined in this document, with one exception:
text and information in appendices can be single-spaced.

= Consecutive page numbering, from the main text through the appendices,
using Arabic numerals, must be used.

= |f appendices are used, they must appear as the last section of the thesis
and must be represented in the table of contents.
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Table 1. Order and Pagination of Thesis
This table shows the proper pagination and arrangement of the entire manuscript. It

also indicates whether a page is optional or required.

Page/Section Required Pagination

Title page Yes No

Copyright page Yes No

Acknowledgments No Yes; begin “”
here (if page included)

Dedication No Yes

Abstract No Yes

Table of contents Yes Yes

List of tables Yes (if tables used) Yes

List of figures Yes (if figures used) Yes

Other items (list of Yes (if included) Yes

abbreviations, etc.)

Body Yes Yes; begin “1”
here

Bibliography Yes Yes

Appendices No Yes

Page Numbering Using Microsoft Word (PC)
The following instructions are compatible with Office suites 2003 or earlier.

Formatting page numbers within margins

PO =

Go to “File.”

Choose “Page Setup.”

Click on the “Layout” tab.

If page numbers are placed at the top of the page, change the
“‘Header” field to at least 1 inch (2.6cm). If page numbers are
placed at the bottom of the page, change the “Footer” field to at
least 1 inch (2.6cm).

Formatting using both Roman and Arabic numerals

-
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. Keep both the introductory material and the body in one document.

Click on the first page of the document and go to: Insert>Page
Numbers—>Format. Change number format to "i, ii, iii...”. This will
number your entire thesis with lower-case Roman numerals.

Click on the first page of the body of the thesis, before the first letter
on that page, and go to: Insert->Break->Section Break Types.

Click on "Continuous" and “Okay.”

. Keeping your cursor on the same page, go back to Insert>Page

Numbers—>Format. Change number format to "1, 2, 3..." and click



on "Start at 1." This will keep the introductory pages numbered

with lower-case Roman numerals and the rest of the thesis

numbered with Arabic numerals.

If page numbers appear on the title page and copyright page, please see the
troubleshooting section of the thesis templates available online at
http://www.grad.umn.edu/current_students/masters/submission.html

Page Numbering Using Microsoft Word (MAC)

Formatting page numbers within margins

aobhwd =

Go to “File.”

Choose “Page Setup.”

In the “Page Settings” list, select Microsoft Word.

Then click on “Margins.”

If page numbers are placed at the top of the page, change the
“‘Header” field to at least 1 inch (2.6cm). If the page numbers are
placed at the bottom of the page, change the “Footer” field to at
least 1 inch (2.6cm).

Formatting using both Roman and Arabic numerals

1.
2.

Keep both the introductory materials and body in one document.
Click on the first page of the document and go to: Insert>Page
Numbers—>Format. Change number format to "i, ii, iii...”. This will
number your entire thesis with lower-case Roman numerals.

Click on the first page of the body of the thesis, before the first letter
on that page, and go to: Insert->Break—>Section Break
(continuous).

Keeping your cursor on the same page, go back to Insert > Page
Numbers - Format. Change number format to “1, 2, 3...” and click
on “Start at 1.” This will keep the introductory pages numbered with
lower-case Roman numerals and the rest of the thesis numbered
with Arabic numerals.

If page numbers appear on the title page and copyright page, please see the
troubleshooting section of the thesis templates available online at
http://www.grad.umn.edu/current_students/masters/submission.html
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Formatting Landscape Pages

Students who choose to use landscape pages in the thesis should be aware of
the following:

= The top margin must be at least 1.5 inches (3.9cm).
= All other margins must be at least 1 inch (2.6cm).
= Page numbers cannot appear in the top margin.

Please see Figure 2 for an example.

_"—

1.5" | Portrait Page 1"

X X
1"
— 1.5"——
| |
1" | x Landscape Page 1"
| |
X X

1II

Figure 2. Format of Landscape Pages
This figure is not to scale and is provided to illustrate how landscape pages should be

formatted. The X’s indicate the acceptable placement of page numbers, and the
measurements indicate acceptable margins along that side.
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Published Work Included as Part of the Thesis

The thesis may include materials that have been published while the author has
been a University of Minnesota graduate student. A letter authorizing use of this
material must be obtained from the publisher, and a copy of this letter must be
submitted to GSSP upon completion of the thesis.

If work has not yet been published but there are plans to publish part of the
materials, the student’s adviser(s) must notify the Graduate School in writing of
the intention to publish a part of the material. The Graduate School’s approval is
not required.

If all or part of the thesis is initially in a format appropriate for submission to a
professional journal, the following guidelines apply:

1.
2.

The thesis must read as one cohesive document.

One set of introductory materials (dedication, abstract, table of contents,
etc.) is necessary, as well as a suitable introduction, transition sections, a
conclusion, and appendices (if applicable) that might not ordinarily be
included in the published manuscript.

A comprehensive bibliography, not usually permitted by journals, must be
included as the last section of the submitted thesis.

The research must have been carried out under the direction of University
of Minnesota graduate faculty and approved by the adviser for
incorporation into the thesis.

The student must be listed as the sole author of the thesis. Editorial or
substantive contributions with general significance made by others should
be acknowledged in the introductory materials; more specific contributions
should be acknowledged by footnotes where appropriate.

Students whose manuscripts include more than the student’s research
must make others’ contributions clear in the thesis.

In rare circumstances use of manuscript reprints of the published articles
themselves are acceptable if they are satisfactorily and legally reproduced
and conform to all the formatting specifications outlined in this document.
Reprints must conform to a style consistent with the rest of the thesis
document.
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Corrections and Revisions

The thesis must be a well-written manuscript that is free from error and ready in
its final version before submission to the Graduate School. Any revisions
required after the final defense by the examination committee must be made and
approved by the adviser (as confirmed by the adviser’s signature on the
signature page) before submission to the Graduate School.

Thesis Writing Support

The Graduate School Writer's Nexus (http://www.grad.umn.edu/gradwriting/) is a
valuable one-stop connection to a multitude of resources and support for
graduate students’ thesis and dissertation writing. Through the Writer's Nexus,
students can quickly link to resources to help them identify funding opportunities,
use the libraries, handle statistics, and write their thesis or dissertation. The
Writer's Nexus also links students to support groups and other useful information
to help them stay on track during the writing stage. A section devoted to issues
specific to international students is also included.
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SECTION 2: SUBMITTING THE MASTER’S THESIS

Overview of Submission Options

Master’s students have three options in which to submit their completed thesis
document. These options are outlined briefly below.

Students may elect to do only one of the following options:
[1Option 1: Graduate School Thesis Submission (Electronic)

Electronic submission is the Graduate School’s preferred submission option.
Students submit a PDF of their thesis to a designated e-mail account,
mastetd@umn.edu; a paper copy of the thesis is no longer needed. This option is
free as students no longer need to pay the binding fee. Students submitting
electronically are required to participate in the University of Minnesota Digital
Conservancy, which allows the thesis to be viewed for free by the public. To
complete the Electronic Submission process, please see page 14.

OR

[ Option 2: Graduate School Thesis Submission (Paper)

Students who elect not to participate in the University of Minnesota Digital
Conservancy, or who cannot submit electronically, must submit two unbound
paper copies of the thesis to 316 Johnston Hall. Students are also required to
pay a $10 binding fee. Students who submit paper copies are not eligible to
participate in the University of Minnesota Digital Conservancy. To complete the
Paper Submission process, please see page 19.

OR

[ Option 3: ProQuest Thesis Submission (Electronic)

Students who elect to publish their thesis through ProQuest must submit a PDF
of their thesis electronically to ProQuest’s Web site. Students submitting
electronically to ProQuest are required to participate in the University of
Minnesota Digital Conservancy, which allows the thesis to be viewed for free by
the public. Students must also pay a $55 publishing fee online at the time of
submission. Submission of the thesis through ProQuest satisfies the Graduate
School’s thesis requirement. To complete submission to ProQuest, please see
page 22.
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Option 1. Graduate School Thesis Submission (Electronic)

The Graduate School strongly encourages students to use the electronic format
for thesis submission because of the advantages offered in terms of cost,
convenience, and accessibility. Students electing to submit electronically are
required to participate in the University of Minnesota Digital Conservancy. Those
electing not to participate must complete Option 2: Paper Thesis Submission,
described on page 19.

Cost: Free! Students submitting electronically do so at no cost, in addition to
saving costs associated with paper, printing, and copying hard copies of the
thesis.

Convenience: Students can submit their theses from anywhere in the world with
internet access, eliminating the need to arrange for delivery of the thesis to the
Graduate School.

Accessibility: Students submitting electronically are eligible to participate in the
University’s Digital Conservancy, which allows the thesis to be viewed for free by
the public.

Submitting the Electronic Thesis

The thesis must be submitted by the end of business no later than the last
working day of the intended month of degree completion. Please follow the
directions below to submit your thesis. Any questions can be directed to
gsmast@umn.edu.

Before beginning the submission process, the student must ensure that:

___The thesis is in its final version. Once submitted, revisions cannot be made
unless the student is instructed by GSSP to do so.

___The full text of the thesis is in one file and in Adobe PDF format.

___The complete file size of the document is less than 25MB (due to e-mail
restrictions). If the file size is larger than 25MB, students must contact the
Graduate School at gsmast@umn.edu.

___ A copy of the signature page is not included in the electronic submission.

___The final PDF document is titled as such: last name_first name Month Year.
For example: Gopher_GoldyOctober2009.pdf

Once the checklist above has been completed, the thesis is submitted to
mastetd@umn.edu. Students must include the following in the subject line of the
e-mail: last name, first name, month and year of graduation.
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Converting Documents to PDF

Macintosh

The ability to create PDF documents is built in to Mac OS X. From any
application, the print dialog box will have an option to save the document as
PDF:

. Page Setup... |

@ | viewt] ( Suppiies...jﬁ O Low I_':Cancelj] E Print j
Save as PDF..
stScript...
j r [

Fax PDF...

Windows

If you have Adobe Acrobat Professional (not the free Acrobat Reader)
installed, you will have the ability to create PDF documents from any application
(such as Word).

If you do not have Acrobat Professional, two free options are listed here. You
may need to contact the IT support staff in your graduate program or the
University’s technology helpline (612-301-4357) for installation help.
e FinePrint pdfFactory Pro is available on Academic Computing’s DVD
tower (your IT support will have access to this)
e PDFCreator is available at
http://www.pdfforge.org/products/pdfcreator/download

After installation, the PDF option will appear along with your other printers in the
print dialog: File > Print...

Print Rl
Printer
Mame; £ grad-alydar Iﬂr_ Properties
Status: - ‘P Find Printer.
Type: r\é grad-seattle_slew d
Where: \ [ Print to file
Comment: r\é ImageMow Printer (] Manual duplex
Page range
\
[OF] [ g Microsoft Office Document Image Writer il B
O Current pg
\
) Pages: [ r\é Microsoft Office Live Meeting 2007 Document Writer Collate
Enter page nu|
separated by Ao y
r_\é Microso ft XPS Document Writer
Print what: |:
i R
. e e -
Print: |:
A\
@ pdfFactory Pro __aling w
-
e
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Materials Submitted to GSSP (316 Johnston Hall)

In addition to submitting the thesis electronically, students must submit (in person
or via mail) the following documents—in hard copy format—to the Graduate
Student Services and Progress (GSSP) office, 316 Johnston Hall, on or before
the end of business no later than the last working day of the intended month of
degree completion.

Signature Page
= Students must submit one copy of the signature page with original
signature(s) and formatted according to the specifications outlined in
Section 1 of this document.
» The signature page is signed by the adviser (and co-adviser if applicable)
to confirm seeing and approving the final version of the thesis.
= Students should not include the signature page in the electronic version.

Title Page
= Students must submit one copy of the title page formatted according to the
specifications outlined in Section 1 of this document.

Deposit Agreement
= Students submitting electronically must sign and submit the Deposit
Agreement form electing to participate in the University Digital
Conservancy (the University of Minnesota’s open-access digital
repository). See University of Minnesota Digital Conservancy, below.
= The Deposit Agreement form is available in the graduation packet and
online at http://www.grad.umn.edu/current_students/forms/DA.pdf.

University of Minnesota Digital Conservancy (UDC)

Students submitting the thesis in digital format are required to make the thesis
available through the University of Minnesota Digital Conservancy, an open-
access digital repository program administered by University Libraries.
Depositing your thesis in the conservancy means that it will be freely accessible
online to the public. Depositing your thesis in the conservancy does not have
any impact on copyright or any other intellectual property rights, which are
retained by the student. Theses deposited in the conservancy should be
considered permanently accessible.

What is the University Digital Conservancy?

The University Digital Conservancy is an open-access online archive of original
works created by University of Minnesota faculty, staff, and students. Theses of
those students who elect not to deposit in the UDC will still be accessible through
the University Libraries, in either paper or electronic form.
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Why add my thesis to the University Digital Conservancy?

The University Digital Conservancy is a great way to make your work visible to
others and to preserve the published record of your work at the University of
Minnesota. The University Digital Conservancy provides:

o Free, worldwide open access to your thesis

e Increased access and visibility through higher search engine rankings
o Full text indexing

o Long-term digital preservation and a permanent URL for your thesis

What about copyright?

You own the copyright to your thesis. Contributing your work to the UDC does
not change its copyright status. When you agree to have your thesis deposited in
the UDC, you grant the University nonexclusive rights to make your thesis
available online, to make copies for preservation purposes, and to create
descriptive metadata about your work that will enhance discovery of your work by
others. Your work will be protected by U.S. copyright law to the same extent it
would be if the user checked out your print-bound thesis from the library. More
information about copyright of your thesis is available at
http://www.lib.umn.edu/copyright/dissertations

Will my thesis be available in University Libraries?

Yes. The Graduate School requires that all theses, whatever their format, be
accessible to the public in University Libraries once any embargo period has
expired. If you submit your work to the conservancy, that will serve as the official
and permanent University Libraries copy.

More information on making your thesis available through the conservancy is
accessible at http://conservancy.umn.edu/dissertations. Theses not made
accessible through the conservancy will still be catalogued in University Libraries,
and a copy of the thesis will be managed by and made available by University
Libraries at the conclusion of any embargo period.

Thesis Embargo Request

In accordance with University of Minnesota Regents policy regarding withholding
research results, a six-month, one-year, or two-year embargo on the release of a
student’s thesis to the public may be requested. During this period, the Graduate
School will not release the thesis to the public. The embargo period begins
immediately after the official degree conferral date (last working day of
graduation month). Students wishing to embargo the thesis must do so directly
through the Graduate School by following the procedure outlined below.
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Students are required to request embargos directly through the Graduate School.
An embargo may be requested by completing a Thesis/Dissertation Embargo
Request form, obtained in 316 Johnston Hall or downloaded from
http://www.grad.umn.edu/current_students/forms/gs20.pdf. The form must be
signed by the student’s adviser and submitted to GSSP no later than the last
working day of the intended month of graduation.

After the requested embargo time expires, the thesis will be released for
circulation. Students will not be contacted once the embargo has expired and are
solely responsible for renewing the embargo request before the expiration date.
Students who wish to renew the embargo or have the embargo lifted before the
expiration date must contact the Graduate School at gsmast@umn.edu.

Students who have chosen to publish their thesis through ProQuest should be
aware that ProQuest will not process the charges for publishing and copyright
until after the embargo is lifted and the thesis released.

Table 2: Materials for Electronic Submission—Quick Reference Guide

Item Format Where to Submit Notes
Submitted | Required
for
Submission
Signature | Hard copy 316 Johnston Hall 1 copy
page Original signature(s)

Title page | Hard copy 316 Johnston Hall 1 Copy

Deposit Hard copy 316 Johnston Hall Available online at
Agreement http://www.grad.umn.edu/cu
form rrent_students/forms/DA.pdf
or in the graduation packet
Thesis Electronic E-mail to: = Must be one file in PDF
mastetd@umn.edu format

= | ess than 25MB
= Must be titled:

last name_first name Month Year

GS13 09/09 18


http://www.grad.umn.edu/current_students/forms/gs20.pdf�
mailto:gsmast@umn.edu�
http://www.grad.umn.edu/current_students/forms/DA.pdf�
http://www.grad.umn.edu/current_students/forms/DA.pdf�
mailto:mastetd@umn.edu�

Option 2: Graduate School Thesis Submission (Paper)

Students are strongly encouraged to submit their theses electronically using
Option 1, described on page 14. In the event a student cannot submit
electronically, they must contact the Graduate Student Services and Progress
(GSSP) office in 316 Johnston Hall (gsmast@umn.edu) to discuss paper
submission. If submitting a paper version of the thesis students must adhere to
the guidelines outlined in Section 1 as well as the following.

Submitting the Paper Thesis

Students completing this option are required to submit two unbound copies of the
thesis to 316 Johnston Hall by the end of business no later than the last working
day of the intended month of degree completion.

Paper

The thesis must be printed single sided on 8 72 x 11-inch white paper. One copy
of the thesis must be on acid-free or cotton paper. The original document or a
copy of the original is acceptable. If photocopies are included in the thesis, care
must be taken to ensure acceptable reproductions. Photocopies must be made
from the original, and all pages must have high contrast with consistently dark
print throughout the thesis.

Size of Volumes

Due to binding considerations, theses more than two inches thick must be
separated into two or more volumes. A title page, in correct format, must be
included at the beginning of each volume and must include the volume number in
the upper-case Roman numerals (Volume |, Volume ll, etc.) centered underneath
the title. Each volume must have a complete table of contents. A copy of the
initial table of contents (from the first volume) for the second volume is
acceptable, but it must be numbered correctly (i, ii, iii).

lllustrative Material

= All illustrative materials (e.g., figures, tables, charts, and graphs) must
have a figure number and a page number and must conform to the margin
specifications, regardless of where the figure caption is located.

= The caption of an illustration may appear on the page facing the
illustration if the reverse side of that facing page is blank. This facing page
(facing the illustration) should also include a page number. The page
number (on the facing page) should be located on the left side or bottom
center to allow for binding. Please note that this is the only instance in
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which it is acceptable to include two pages of text that face each other and
have the page number on the left side of a page.

Tables, Charts, and Graphs

= Students may choose to include tables, charts, and graphs as separate
materials at the end of the thesis (in an appendix) or embedded within
the text. Students should consult their program to ensure that they are
adhering to their program’s stylistic conventions.

= Reduced photocopies of tables, charts, and graphs are acceptable if
they are legible and within the specified margins. If the material is
illegible after reduction, full-sized fold-out copies may be used. Care
must be taken (for binding purposes) not to fold paper into the left side
margin. Oversized material submitted separately—for example, in a
mailing tube—is not acceptable.

= If hand lettering or drawing is necessary, a permanent black-ink pen
may be used. Felt-tip pens must not be used, as the ink may bleed
through to adjacent pages.

= Captions may be single-spaced.

CD ROMS and Discs

= CD ROMS and discs included with the thesis must be submitted in an
envelope and clearly marked with the author’'s name, graduation month
and year, and title of the thesis.

= Students also must indicate what supplemental material is being
included (e.g., additional charts, graphs, color images, or databases).
These supplemental materials must be in one document, and PDF
format is recommended.

Thesis Embargo Request

In accordance with University of Minnesota Regents policy regarding withholding
research results, a six-month, one-year, or two-year embargo on the release of
the student’s thesis to the public may be requested. During this period, the
Graduate School will not release the thesis to the public. The embargo period
begins immediately after the official degree conferral date (last working day of
graduation month). Students wishing to embargo the thesis must do so directly
through the Graduate School by following the procedure outlined below.

Students are required to request an embargo directly through the Graduate
School. An embargo may be requested by completing a Thesis/Dissertation
Embargo Request form, obtained in 316 Johnston Hall or downloaded from
http://www.grad.umn.edu/current_students/forms/gs20.pdf. The form must be
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signed by the student’s adviser and submitted to GSSP no later than the last
working day of the intended month of graduation.

After the requested embargo time expires, the thesis will be released for
circulation. Students will not be contacted once the embargo has expired and are
solely responsible for renewing the embargo request before the expiration date.
Students who wish to renew the embargo or have the embargo lifted before the
expiration date must contact the Graduate School at gsmast@umn.edu.

Students who have chosen to publish their thesis through ProQuest should be
aware that ProQuest will not process the charges for publishing and copyright
until after the embargo is lifted and the thesis released.

Table 3: Materials for Paper Submission—Quick Reference Guide

Students submitting a paper thesis must submit the following materials to GSSP,
316 Johnston Hall, on or before the end of business no later than the last working
day of the intended month of graduation. Students are asked to allow sufficient
time for review of the thesis and submission of materials and to arrive in the
GSSP office no later than 4 p.m. The quick reference guide below outlines what
materials need to be submitted. More detailed information about each item can
be found in Section 1 of this document.

Item Format Where to Submit Notes
Submitted | Required for
Submission
Signature | Hard copy 316 Johnston Hall 1 copy with original
page signature(s)
Title page | Hard copy 316 Johnston Hall 1 copy
Thesis Hard copy 316 Johnston Hall = 2 copies (1 copy on
acid-free or cotton
paper)
= Unbound
= Formatted to the
specifications
outlined in Section 1
Payment 316 Johnston Hall = $10 total
= Exact cash or check
acceptable
= Checks made
payable to the
University of
Minnesota
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Option 3: ProQuest Thesis Submission (Electronic)

The University of Minnesota does not require publication of the master’s thesis.
Students who wish to do so may submit their thesis electronically to ProQuest.
Students using this option are required to participate in the University of
Minnesota Digital Conservancy. Those electing not to participate must complete
Option 2: Paper Thesis Submission on page 19.

Submitting the Thesis to ProQuest

The thesis must be submitted online on or before the end of business no later
than the last working day of the intended month of degree completion. Please
follow the directions below to submit the thesis online to ProQuest. Any questions
can be directed to gsmast@umn.edu.

Before beginning the submission process, the student must ensure that:

___The thesis is in its final version. Once submitted, revisions cannot be made
unless the student is instructed to do so by GSSP.

___The full text of the thesis is in one file.

___The full text of the thesis is in Adobe PDF format. If the text is not already in
PDF format, a converter is available on ProQuest’s submission site.

___If the PDF converter is used, check the document for accuracy before
uploading. Note that it may take one or more days to receive the converted
PDF, so please plan accordingly.

___The complete file size of the document is less than 100MB.

___ A copy of the signature page is not included in the electronic submission.

___ A credit or debit card is readily available for online payment.

Once the checklist above has been completed, the thesis is submitted at
http://www.etdadmin.com/umn. Follow the instructions included on the Web site.

Materials Submitted to GSSP (316 Johnston Hall)

In addition to submitting the thesis online to ProQuest, students must submit the
following documents—in hard copy format—to GSSP, 316 Johnston Hall, on or
before the end of business no later than the last working day of the intended
month of degree completion.

Signature Page
= Students must submit one copy of the signature page with original
signature(s).
= The signature page is signed by the adviser and the co-adviser, if
applicable, to confirm seeing and approving the final version of the thesis.
= Students should not include the signature page in the electronic version.
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Title Page
= Students must submit one copy of the title page formatted to the
specifications outlined in Section 1 of this document.

Deposit Agreement
» Students submitting online to ProQuest must sign and submit a Deposit
Agreement form electing to participate in the University Digital
Conservancy, the University of Minnesota’s open-access digital repository.
See information about the conservancy on page 26.
= The Deposit Agreement form is available in the graduation packet and
online at http://www.grad.umn.edu/current_students/forms/DA.pdf.

Publication, Copyright, and Distribution of the Thesis

The University of Minnesota does not require publication of the master’s thesis.
In order to submit the thesis to ProQuest, students must complete the Publishing
Agreement, which is submitted online to ProQuest along with the electronic
submission of the thesis. Students must also submit the Deposit Agreement form
to GSSP, 316 Johnston Hall, allowing distribution of the thesis through the
University of Minnesota Digital Conservancy.

ProQuest will produce and store a microfilm negative, as well as electronically
reproducing the full text of the thesis abstract in Thesis Abstracts Online.

“ProQuest’s computerized search and retrieval system will cite your thesis in
response to any inquiry using search items included in your title or abstract.
Researchers...can also search ProQuest’s database and place orders online.”
(Publishing your Master’s Thesis, 2007)

Additionally ProQuest will sell hard copies upon request.

“ProQuest will pay a 10% royalty on ALL sales of your thesis. Royalty payments
must exceed $10.00 in a calendar year to be paid.” (Publishing your Master’s
Thesis, 2007)

Publication by online submission does not preclude publication later by other

methods. Please note that the Publishing Agreement form grants ProQuest the
right to distribute theses and abstracts by electronic means.
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Cost

The fee for publishing a thesis is currently $55. ProQuest will register the
copyright for an additional fee of $65 (see copyright section below for
more information). These fees are subject to change; contact GSSP for
current rates.

Payment of the publishing fee and optional copyright fee is completed
online at the time of submission. The following electronic payment types
are acceptable: Visa, MasterCard, American Express, or a debit card with
a major credit card company logo on it.

Abstract

Submission of the abstract is done online with the thesis submission.
ProQuest no longer has a word limit on the abstract submitted separately
from the thesis. Note, however, that ProQuest will continue to publish print
indices, which do have a word limit of 350 words. If the abstract exceeds
these word limits, ProQuest will truncate the abstract and remove any
non-text content.

The abstract will be available to other scholars who may wish to learn
more about the thesis topic before ordering a copy through ProQuest.

Copyright

There are two aspects to copyright considerations: (a) copyright of the thesis,
and (b) the use in the thesis of material copyrighted by others.

(a) The Copyright Act adopts the principle of “automatic copyright.” Works
created after January 1, 1958, are copyrighted under the federal statute
upon their creation. A work is “created” when it is fixed in a tangible form
of expression, e.g., written or drawn on paper; sculpted or made; placed
on film, disc, or videotape; or recorded on sound tape. While registration
with the Library of Congress and use of a copyright notice are not
conditions for securing the initial copyright for these works, “registration”
and “notice” are still important. If you fail to observe these formalities,
especially upon publication, your material may not be legally protected.
Registering your copyright with the U.S. Copyright Office will establish a
public record and allow you additional legal rights. Registration of
copyrights with the U.S. Copyright Office may be made for all works
before or after publication.

Copyright notice consists of the symbol © or the word “copyright,” the
name of the owner of the copyright, and the year that the work was
created. This notice should be affixed in a manner and location that give
reasonable notice of the copyright claim.

If ProQuest is to register a copyright for a thesis on the student’s behalf
with the Library of Congress (of which the U.S. Copyright Office is a
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subsidiary), the copyright authorization in the publishing agreement
section must be completed online. The cost of this method of copyrighting
is currently $65. This fee is subject to change; consult GSSP
(gsmast@umn.edu) for the current rate.

(b) The Copyright Act provides for the legislative recognition of “fair use” of
copyrighted materials. The fair use of copyrighted work for purposes such
as criticism, comment, news reporting, teaching (including multiple copies
for classroom use), scholarship, or research, is not an infringement of
copyright. The student, as author, bears the responsibility of determining
whether a use is fair or not. In determining whether the use in any
particular case is fair use, the factors to be considered include:

e the purpose and character of the use, including whether
such use is commercial in nature or is for nonprofit educational
purposes

e the nature of the copyrighted work

e the amount and substantiality of the portion used in relation
to the copyrighted work as a whole

o the effect of the use upon the potential market for or value of
the copyrighted work

Note: If a thesis includes materials from journal articles or other publications
authored by the student and if the student did not retain sufficient rights to
include the material in the thesis, a letter authorizing use of this material must be
obtained from the publisher and submitted to GSSP. Consult publication
agreements to determine what rights were retained. The letter must be submitted
to GSSP along with the Deposit Agreement form. Read more about this is in the
section “Published Work Included as Part of the Thesis” in Section 1 of this
document.

For questions related to copyright, students may also consult University Libraries
at 612-624-6536 or copyinfo@umn.edu. Their Web site also provides students
with helpful information: http://www.lib.umn.edu/copyright/. University Libraries
can provide information but not legal advice about copyright.

Questions about patent and trademark are legal in nature and should not be
considered lightly. For questions, legal counsel should be consulted. The
Graduate School staff is not authorized to answer legal questions.
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University of Minnesota Digital Conservancy (UDC)

Students submitting the thesis in digital format are required to make the thesis
available through the University of Minnesota Digital Conservancy, an open-
access digital repository program administered by University Libraries.
Depositing a thesis in the conservancy means that it will be freely accessible
online to the public. Depositing a thesis in the conservancy does not have any
impact on copyright or any other intellectual property rights, which are retained
by the student. Theses deposited in the conservancy should be considered
permanently accessible.

What is the University Digital Conservancy?

The University Digital Conservancy is an open-access online archive of original
works created by University of Minnesota faculty, staff, and students. Theses of
those students who elect not to deposit in the UDC will still be accessible through
the University Libraries in either paper or electronic form.

Why add my thesis to the University Digital Conservancy?

The University Digital Conservancy is a great way to make your work visible to
others and to preserve the published record of your work at the University of
Minnesota. The University Digital Conservancy provides:

free, worldwide open access to your thesis

increased access and visibility through higher search engine rankings
full text indexing

long-term digital preservation and a permanent URL for your thesis

What about copyright?

You own the copyright to your thesis. Contributing your work to the UDC does
not change its copyright status. When you agree to have your thesis deposited in
the UDC, you grant the University nonexclusive rights to make your thesis
available online, to make copies for preservation purposes, and to create
descriptive metadata about your work that will enhance discovery of your work by
others. Your work will be protected by U.S. copyright law to the same extent it
would be if the user checked out your print-bound thesis from the library. More
information about copyright of your thesis is available at
http://www.lib.umn.edu/copyright/dissertations

Will my thesis be available in the University Libraries?

Yes. The Graduate School requires that all theses, whatever their format, be
accessible to the public in the University Libraries, once any embargo period has
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expired. If you submit your work to the conservancy, that will serve as the official
and permanent University Libraries copy.

More information on making your thesis available through the conservancy is
accessible at http://conservancy.umn.edu/dissertations. Theses not made
accessible through the Conservancy will still be catalogued in University
Libraries, and a copy of the thesis will be managed by and made available by
University Libraries at the conclusion of any embargo period.

Thesis Embargo Request

In accordance with University of Minnesota Regents policy about withholding
research results, a six-month, one-year, or two-year embargo on the release of a
student’s thesis to the public may be requested. During this period, the Graduate
School will not release the thesis to the public. The embargo period begins
immediately after the official degree conferral date (last working day of
graduation month). Students wishing to embargo the thesis must do so directly
through the Graduate School by following the procedure outlined below.

Students are required to request embargos directly through the Graduate School.
An embargo may be requested by completing a Thesis/Dissertation Embargo
Request form, obtained in 316 Johnston Hall or downloaded from
http://www.grad.umn.edu/current_students/forms/gs20.pdf. The
Thesis/Dissertation Embargo Request form must be signed by the student’s
adviser and submitted to GSSP no later than the last working day of the intended
month of graduation.

After the requested embargo time expires, the thesis will be released for
circulation. Students will not be contacted once the embargo has expired and are
solely responsible for renewing the embargo request before the expiration date.
Students who wish to renew the embargo or have the embargo lifted before the
expiration date must contact the Graduate School at gsmast@umn.edu.

Students who have chosen to publish their thesis through ProQuest should also
be aware that ProQuest will not process the charges for publishing and copyright
until after the embargo is lifted and the thesis released.
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Table 4. Materials for ProQuest Submission—Quick Reference Guide

Item Format Where to Submit Notes
Submitted Required
for
Submission
Signature Hard copy 316 Johnston Hall 1 copy with original
page signature(s)
Title page Hard copy 316 Johnston Hall 1 copy
Deposit Hard copy 316 Johnston Hall http://www.grad.umn.edu/c
Agreement urrent_students/forms/DA.p
form df
Thesis Electronic Online at: = Must be onefile in
http://www.etdadmin.com/umn PDF format
= 100MB or less
Abstract Electronic Online at: Should be 350 words or
http://www.etdadmin.com/umn less. If more than 350, UMI
will truncate in print indices
Publishing Electronic Online at:
Agreement http://www.etdadmin.com/umn
Payment Electronic Online at: $55* for publishing
http://www.etdadmin.com/umn $65* for copyright (optional)
= Payments
accepted: Visa,
MasterCard,
American Express,
debit card with
major credit card
logo
*Fees are subject to change
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Appendix A

Formatting Guidelines Checklist

This checklist will help to ensure that all prescribed formatting guidelines for the
thesis have been met and that formatting errors that would delay thesis
submission and may delay degree conferral can be avoided.

__The top, right, and bottom margins are at least 1 inch (2.6cm); the left
margin is at least 1.5 inches (3.9cm).

___The manuscript is formatted so that the page numbers, headers,
footers, charts, graphs, etc., do not appear in the margins.

___The signature page, title page, and copyright page are not numbered;
all other introductory pages are numbered in correct order, beginning with
a lower Roman numeral one (i).

__The title page has the correct month and year listed. Month and year
must correspond to the month and year that all requirements are
completed (not necessarily the month and year of the defense).

__The name listed on the signature page and title page is the official
name on record with the Office of the Registrar.

The table of contents includes all sections (and the corresponding page
numbers) following the table of contents.

__The first page of the body of the text starts with an Arabic numeral one
(1), and is numbered consecutively, on every page, through the rest of the
body, including bibliography and appendices.

The bibliography is comprehensive and is included as the last section
of the thesis (unless appendices are included, in which case the
appendices are the last section).

__Standard font, in 10 point or larger is used; the manuscript is double or
1% spaced.

___Landscape pages have correct page-number placement and margins.
Please see the Figure 2: Format of Landscape Pages on page 10.
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Appendix B

Ordering Thesis Copies for Graduate Program or Personal Use

To order copies of the thesis for graduate program or personal use, students can
use any one of the following options: the University of Minnesota Bindery, the
microfilming company Proquest/UMI, or other printing companies such as
Kinkos. Information about outside printing and binding companies is readily
available online and in phone directories.

Note: The Graduate School does not endorse or recommend any printing or
binding company. Students are not required to use any of the options listed
below for ordering personal or graduate program copies. The Graduate School
does not provide binding services.

e University of Minnesota Bindery
*= Provides Class A and soft cover binding.
= Provides photocopy services.
= Several copy centers are located around campus.
= Contact 612-626-0507 or http://www.bindery.umn.edu/thesis.htm
for up-to-date prices and services.

e Proquest/UMI

»= Provides hardcover and soft cover binding.

= More information about pricing and products can be found online at
http://www.proquest.com/en-US/. Note: Students who wish to order
copies of their theses through ProQuest must submit their theses
electronically to ProQuest (Option 3) and pay the additional
publishing fees.

= Delivery times vary.
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Appendix C

Thesis Submission Comparison Guide

Option 1

GS Electronic

Option 2

GS Paper

Option 3

ProQuest Electronic

Signature page

1 hard copy to 316
Johnston Hall
Original signature of
adviser

1 hard copy to 316
Johnston Hall
Original signature
of adviser

= 1 hard copy to 316 Johnston
Hall
= Original signature of adviser

1 hard copy to 316

1 hard copy to 316

= 1 hard copy to 316 Johnston

Title page Johnston Hall Johnston Hall Hall
. Hard copy to 316 = Hard copy to 316 Johnston hall
Deposit Johnston hall N/A
Agreement
Thesis E-mail to: 2 unbound hard = Online at
mastetd@umn.edu copies submitted http://www.etdadmin.com/umn
to 316 Johnston
Hall
$10 total = $55* for publishing
Paym ent N/A Check or exact = $65* for copyright (optional)
cash = Paid online
*fees subject to change
N/A N/A = Online at
Abstract http://www.etdadmin.com/umn
- = Online at:
Publishi ng N/A N/A http://www.etdadmin.com/umn
Agreement
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